Using OfficeMix to Spice Up Your WebCampus Course Content
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What is Office Mix?

Office Mix is a powerful tool that you can use to turn your PowerPoint presentations into interactive
lessons. For example, you can record:

e Audio of yourself narrating a lesson
e Video of yourself speaking to students
e Ink being drawn on your slides

Imagine if you were music faculty and you wanted to teach a student how to play guitar. Youcould
record yourself playing music, include voiceover narration of the technique you're using, and then show
your student how to read sheet music by drawing lines from the staves to the strings of a guitar, just like
you would if you were sitting in front of him or her. But unlike a traditional classroom settingwhere
you're limited by the size of the room and the number of students, Office Mix allows you to teach in a
virtual classroom of unlimited capacity while making each student who views the lesson feel likeyou're
talking directly to him or her.

To your students, these lessons look and feel just like videos that they can watch at their own pace and
re-watch as often as they need. If you add content like quizzes, polls, and even lessons from Khan
Academy, then your students can do more than just watch the videos; they can interact with themand
record their answers to your questions.

You distribute each lesson by posting or embedding web address to in WebCampus. The Mix is stored
on the Office Mix website. With Office Mix's analytics capabilities, you can see which students viewed
each lesson, how they answered your questions, and how much time they spent on each slide.



Office Mix adds value to PowerPoint
In addition to all the rich features available in PowerPoint, Office Mix lets you:

e Record audio or video narration of your slide deck.

e Insert content that users can interact with, like quizzes, polls, and simulations.

e Record audio or video of other applications in action and insert them in your slide show.
e Take a screenshot of another open window and insert it in your slide show.

e Preview and publish your mix to the web or export it as a video.

e Share your mix with whomever you choose and share it on social media.

e Review data about who viewed your mix and how long they spent on each slide.

Publishing components

Once your mix is ready to publish, you decide who you want to share it with and how:

e Manage the permissions:
o Sharing must be “Public or Unlisted” to automatically show in your WebCampus List

Permission & Sharing
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fer Creative Commons

Mark it as private so only you can see it.

Share it with anyone who has the URL to the mix but restrict access to your organization.
Share it with anyone who has the URL to the mix, provided they sign in to Office Mix.
Share it with anyone who has the URL to the mix, without requiring them to signiin.
Share it publicly so that it's also available from search engines and potentially from

the Office Mix Gallery.

e Send an email containing the URL from your default email program.

e Share it on any website, including Facebook, Google+, Twitter, Pinterest, LinkedIn, and others.
e Embed it on another website so that it plays in a small, medium, or large frame.
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Playback components

After you publish your mix, the following elements are available to play it on any device in anHTML5-
compliant browser (e.g., Internet Explorer, Google Chrome, Firefox, and others):

e Play and Pause controls

e Next and Back controls to move forward or backward one slide at a time
Slide Sorter view to see thumbnails of all the slides in the mix

e Closed captioning

e Playback at different speeds from 80% slower to twice as fast

e Coming soon: playback via mobile applications



Data analytics components
After your mix has been viewed by one or more people, you can see data aboutit:

e Byslide
e By visitors (i.e., viewers are visitors that viewed the slide more than once)
e By exercises (for mixes that contain interactive content like quizzes, polls, etc.)

by slides by visitors by exercises
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Getting a User and Downloading OfficeMix

1. GetaUserAccount: signup.ive.com

2. Downloading the OfficeMix FREE Add-In: http://mix.office.com
****powerPoint needs to be CLOSED when you do this. ******

3. Office Mix Gallery: https://mix.office.com/watch/1tn085hjleanh

Getting started

Now that you've begun planning your online lessons, here are a few tips and tricks to get you up and
running with Office Mix successfully:

1. Make sure you're using PowerPoint 2013.

Most of our college computers should have this version. If you're not sure which version you're using,
click File on the menu bar, and then click Account to see the version number. (If you don't see a File >
Account item, find out which older version you're using.)

2. Make sure your slide deck is saved with a PPTX extension.

If you want to start with a slide deck saved in the older, PPT format, open it in PowerPoint 2013. Then
click File on the menu bar, and click Convert:

@'

Convert


http://mix.office.com/
https://mix.office.com/watch/1tn085hj1eanh

PowerPoint will open the Save As dialog with the filename and PPTX extension already filledin.

3. Use an external web cam for higher-quality video.

Built-in cameras (and mics, for that matter) are suitable for most tasks. But if you want more
professional-looking video, invest in an external web cam. If you're using Office Mix on a tabletor laptop
and you're inking with a stylus, an external camera and mic will allow you to minimize stylus noise.

4. Test your audio level before you start recording.
No matter how engaging the content of your lesson is, your video content is only as good as the quality
of your audio. Do a test recording with your mic and adjust the volume to find the optimal setting. To do
this:

On the Mix tab, click Slide Recording,

o Inthe Audio and Video pane, select your microphone in the second drop-down list.

On the slider below the volume indicator, drag the square left to lower the volume or right to

increase it.
If the sound quality is poor, use an external microphone, like Blue Yeti or Nessie, instead of the mic
built into your laptop. Even a headset will produce better quality audio than mostbuilt-in mics.

As soon as you finish your first slide recording, play it back.

Before you get too far down the road of creating your mix, you'll want to make sure your audio and
video sound and look the way you expect. So as soon as you finish your first slide recording, play it
back. To do this, click Preview Slide Recording:

-

Preview Shde Delete Slide

Recording Recording

ng Tools
If the audio's too soft or too loud, or if the camera isn't positioned just right, click Delete Slide
Recording. Then make adjustments before you re-record.

Pause briefly between slides.

Another way to segment your content is by slide. If you make one slide recording per slide, then it's
even easier to re-record when you make a mistake. If you segment your content in this way, it gives
you the opportunity to think about itin a modular way. It also gives you the freedom to add exercises
at the end of each segment to check your students' comprehension.

Use video where essential; use audio and inking for greater focus on content and delivery.

When you create an online lesson, you'll want your students to reap the same benefits from your
teaching style as if you were delivering the lesson in person. If you decide to include atalking-head video,
make sure to create good eye contact by speaking directly to the camera, and speak ina conversational
tone so that your students feel like you're talking directly to them. But whenyou want them to focus on
the slide content, forego the video and instead draw on your slides (i.e., use inking) while talking.

Upload drafts as you go-- but clear the video checkbox until your final draft.
Make sure to save your work while you're creating your mix. But clear the checkbox that creates a video
version until you're ready to upload your final draft. That way, you'll speed up the publishing process of
interim drafts. To do this:

e Onthe Mix tab of the ribbon, click Upload to Mix:



e Inthe Upload to Mix pane, clear the checkbox under Enable playback on mobile devices.

e When you're ready to upload your final draft, check that box. Iuj )
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How To: Create a slide recording Preview Upload My
to Mix  Mixes

What is a slide recording? i

A slide recording is a recording of a PowerPoint slide show enhanced with audio, video, and/orinking
that you create by using Office Mix. When you create a slide recording, Office Mix adds up to 3 different
types of information to yourslide:

e A "media shape" that contains your audio-video clip

e Ink as a bitmap

e Timings (not visible on the slide) that are used during playback so that your clips and ink strokes
start and end at the right times

For instance, the slide recording below contains video (in a media shape), inking (as a bitmap), and
timings (which are notvisible):

Video

Recording tips . Inking

Lintaume Lanarret Ofue Mo lepm

Slide

To see what a slide recording looks and sounds like, you can preview it in Office Mix at the time you
create it, or you can simply watch your mix on the web after you publish it by going to your My Mixes
page on the Office Mix website.

How to create a slide recording
The easiest way to create a slide recording is to create a PowerPoint presentation first. Then record on
top of your existingslides. -

1. Go to the slide where you want your recording to begin.

Shid
2. On the ribbon, select the Mix tab. F‘.ecc&lrd’?i-ng
3. Inthe Record group at the far left of the tab, click Slide Recording: Record

At this point, before you begin recording, you should decide which elements you want torecord.

To add audio and/or video
Under Audio and Video to the right of yourslide:

1. Select the size and resolution of the video you’ll record:
o If you want the video to appear as a thumbnail, click Thumbnail. This option creates a low-
resolution recording.
o Tofill the screen with your video, click Full Screen. This option creates ahigh-resolution
recording.
2. Select the camera you want use.
o If you're recording on a laptop and you don’t have an external camera connected, select
Integrated Camera in the drop-down list.



o If you want to record audio only, select No camera instead.

3. Select the audio device you want to use.

o If you want don’t want to record any sound, select No microphone.

4. Adjust the volume by dragging the square left (lower) or right (louder) along the slider.

To add inking
Under Inking to the right of your slide:

1. Click the pen (Fine Pen, Medium Pen, Thick Pen) you want to use to draw on yourslide.

o  After you begin inking, you can click the Eraser to remove all of your ink strokes.

2. Click the color of the ink you want to use.

You’re now ready to begin recording.

To record
Use the buttons in the Slide Recording tab:

@

Record Previous Next Slide
Slide A
A

| Click Record to If your slide contains
| beginrecording. Animations, use
Previous Animation
and Next Animation
Click Stop to to play the
Stop recording. animations.

Click Previous Slide and Next Slide
to go backward or forward one slide.

How To: Create a screen recording

What is a screen recording?

Afteryouclick
Stop, click
Preview Slide
Recordingto
seewhatyou
recorded.

Ifyou don'tlike
whatyou
recorded, click
Delete Slide
Recordingto
deleteit. Then
start over.

The terms "slide recording" and "screen recording" sound similar but differ primarily in

this way:

e Aslide recording show viewers activity on PowerPoint slides.
e A screen recording show viewers activity in any other program on your computer,

including Windows itself.

How to create a screen recording

Follow these steps to create a screen recording of the last program that wasactive:

1. On the Mix tab, click Screen Recording:

Slide Notes
A

Ifthisslide has
notes, click Slide
Notesto show
them justbelow
this button so
they’ll appear close
to yourwebcam
and youcan read
themwithout
looking down.
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2. Onthe control dock at the top of the screen, click Screen Area:
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The cursor will change to crosshairs:

Note that Audio will already be selected so you can record voice narration at the same timeas
your screen actions. If you don’t want to record audio, click Audio to deselect it.

3. Click and drag the area of the screen you want to record. To record the entire screen, click in the
top-left corner of the screen, and drag the crosshairs to the bottom-right corner of thescreen.
Note that you cannot select an area smaller than 64 x 64 pixels.

4. Click Record.
The control dock will slide up and out of view while you record. To pin it in place, click the pushpin
in the bottom-right corner of the dock.
5. To control your recording:
o Click Pause to temporarily stop the recording:
Pause

o Click Record to resume recording.
o Click Stop to end your recording:

00:071:22

The screen recording will automatically be added to the current slide after you click Stop.

Upload to Mix

Why create a mix instead of a video file?

Creating a mix by uploading it to your My Mixes page on the Office Mix website has several advantages
to exporting it a video:



¢ You don't have to worry about it saving it locally because Office Mix saves it in the
secure Microsoft cloud.

e You can distribute it easily by sharing the unique URL of your mix.

e Interactive elements in your mix remain interactive after you upload it.

e Office Mix collects analytical data about the mix and makes that data available on your My Mixes
page.

e You can set permissions for your mix to dictate who can and cannot view it.

e You can share your mix on social networking sites like Facebook, Google+, Twitter, Pinterest,
and LinkedIn as part of the publishing process, or even after the mix has already been uploaded.

How to upload a mix
To upload a mix to your My Mixes page on the Office Mix website:

1. On the Mix tab in the Mix group, click Upload to Mix:
Preview Upload My
to Mix  Mixes
flix
2. Inthe Upload to Mix side pane, click Next.
3. Ifyou aren’t already signed into Office Mix, choose which of the following account types
you’ll sign in with:

o your Microsoft Account

o your organizational account

o your Facebook account

o your Google account
4. Click your account ID.

5. Indicate how you want the mix to be uploaded:

o If you are creating a new mix, select This is a new mix. Otherwise, to overwrite a mix
you already uploaded, select Updating an existing mix and select the mix that you want
to overwrite.

o If you also want to create a video version of your mix, select Enable playback on
mobile devices. Note the following:

e Selecting this option increases the upload time.

e If you don’t select this option, viewers will still be able to view your mix on
mobile devices, provided those devices are connected to the Internet.

e If you don’t select this option at this time, you can still export your mix as a video
after it has been uploaded to your My Mixes page.

o Click Next. At this point, Office Mix will begin uploading your mix.

6. Inthe side pane, click Show me my mix.

At this point, Office Mix will open the Details page of your mix on the Office Mix website. Fill in the
details as follows:

1. Type a title for your mix. The title will appear next to a thumbnail of your mix on your My Mixes

page.
2. Type a free-form description of your mix. The description will appear below the creation data and



duration of your mix on your My Mixes page.
3. Set the Permission & Sharing options.
4. If you want to email the URL of your mix to a recipient, click the Email icon at the bottom of

5. If you want to add closed captioning to your mix, see Adding close captions.
6. Click Save.

Why export a mix as a video?

Export to video is the Office Mix export option that lets you save your mix as a video that contains the
audio, video, and inking you created with Office Mix but not contain any interactive content (apps,
quizzes, simulations, etc.). This option is designed for the following scenarios:

e You want viewers to be able to watch your mix without connecting to the Internet.

e You don't want your mix to be stored in the secure Microsoft cloud.

e You want to save a copy of your mix locally (i.e., on your hard drive or other local storage device).

e You want to publish your mix on Office 365's video portal.

e You want to publish your mix to YouTube. (If you plan to make your mix available as aYouTube
video, it's a good idea to add the URL of your mix to the end of your video so people can enjoy
the full mix experience on http://mix.office.com.)

How to export a mix to a video

If you're already familiar with PowerPoint's File > Export > Create a Video feature, Office Mix's Export
to video feature has the same options with more descriptivewording.

1. On the Mix tab in the Video group, click Export to video.
Export Exportto Publish to
to Video SCORM 0365 Video
YWideo
2. Inthe Export to Video side pane, choose a video resolution from the Choose video size list:
o For high-definition video suitable for viewing on a computer monitor, TV screen, or other
HD display, select Full HD (1080p).
o  For high-definition video suitable for HD computer screens, select Computer & HD
Displays (720p).
For web viewing suitable and standard DVD resolution, select Internet & DVD (480p).
For viewing on small portable devices like mobile phones, phablets, and tablets, select
Portable Devices (240p).
3. In Seconds spent on each slide, type the number of seconds to wait before the mix advances
to the next slide. This setting applies only to slides that do contain a video or interactive
content.

4. Click Next.
5. Inthe Save As dialog, choose a filename and location for your video and click Save.

How to export a video while uploading a mix
When you upload a mix (by clicking Upload to Mix on the Mix tab), you can create a video version of


https://officemix.uservoice.com/knowledgebase/articles/505262-how-to-add-closed-captions
http://mix.office.com/
https://support.office.com/en-au/article/Turn-your-presentation-into-a-video-c140551f-cb37-4818-b5d4-3e30815c3e83#__toc252973124

your mix at the same time that you publish your mix. To take advantage of this option:

1. Follow the How to upload a mix steps on the Create a mix page.
2. Instep 5, select Enable playback on mobile devices box.

Office Mix will bundle the video in a package with the mix. When viewers watch your mix from a
mobile device (by clicking the URL that you send them), the video will play instead of the mix inside the
mobile device's video player. Slides containing interactive content will notappear.

Tips & tricks

Remember that unlike a mix, a video plays from start to finish without user interaction (except to pause,
play, and rewind). Follow these tips and tricks below to make sure your exported video plays back the
way you expect.

1. Do not use slide transitions.
There are no slide transitions in a video. To change the amount of time that is spent on eachslide,
change the default value of 5 in the Seconds spent on each slide box.

2. Expect animations to play automatically.
If you added animation effects in PowerPoint that start "On Click," they will play automaticallyin
the video version.

3. Do not create videos when saving interim versions of your mix.
Saving a video version of your mix can be a time-consuming process because PowerPoint plays
the slideshow during the export process. For example, if the runtime of your PowerPoint
presentation is one hour, it will take just over one hour to export it to video. To speed up the
uploadprocess, clear the Enable playback on mobile devices box, and enable it only when you're
ready toupload your final version.

How To: Use Interactive content:
This is not available yet but will probably be in the summer!

Lab Apps for Office
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idecs and Apps

cK < cR = Fluid

CK-12 Science  PIET Sims - CK-12 Math Code Hunt for  FluidMath CGeoGebra
Rescurces Science / Math  Rescurces Office Mix (Beta)
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What is interactive content?

Interactive content is readymade content that you insert into a mix and that viewers can interact with
directly. Quizzes, polls, science and math simulations, and videos from Khan Academy are all examples
of interactive content. They provide a level of interactivity above and beyond what you can createin
PowerPoint alone.

How to use interactive content

As faculty, you can use the interactive content under Quizzes and Polls as a formative assessment,
checkpoints, to make sure your students understand the material presented up to a certain point
before they continue viewing a mix. For instance, you can insert a quiz and determine the threshold, or
score, that a student must meet or exceed in order to move to the next slide. If a student falls below
that threshold, you can suggest that he or she review the material again.

You can also use the content under Videos and Apps to enhance your lessons about certain concepts by
allowing students to control and alter examples of those concepts in action. For instance, in ascience
lesson about light and color, students can explore the ways that changing the wavelength of a
monochromatic beam changes the way that color is seen by the human eye:

Bulb Color

Colocvisen BE a

How to add interactive content to a mix

The most efficient way to make use of interactive content in a mix is to create your lessonin
PowerPoint, and then decide where this type of content can be inserted to test students'
comprehension or illustrate a concept.

1. Go to the slide where you want interactive content to appear.
2. On the ribbon, select the Mix tab.
3. Inthe Insert group, click Quizzes Videos Apps:

' =4 [0 m ‘*')

Quizzes Screen  Screenshot Insert  Insert
Videos Apps Recording = Video Audio

Insert

4. At the top of the Lab Apps for Office box:
o Click MY APPS to insert an app that you already downloaded.
o Click STORE to insert an app, which automatically adds it to your list of MY APPS.
5. Click the app you want to insert to read a description of it.
6. Toinsert the app, click Trust It. Or click Cancel to return to the list of apps without inserting it.
7. Tosee the app the way your students will see it, press F5 or click Slide Show in the bottom-right.



How to view analytics from quizzes and polls

After you publish your mix, Office Mix will begin collecting data for all the quizzes and polls you
inserted in the mix. To view this data:

e Go tothe list of uploaded mixes on your My Mixes page
at https://mix.office.com/MyMixes/Uploaded.
For each mix that contains one or more quizzes or polls, click Analytics:

Details |||||| Analytics E‘ Discussion i Presentation IE Delete

e Under the title of your mix, click by exercises:

by slides by visitors by exercises

Tips & tricks

e Use interactive content to gauge a student's progress and comprehension of the material
you're teaching in a mix. This content is not intended to be used to grade students.

e After you add interactive content to a slide, you can copy and paste it on other slides inyour
presentation. This method is particularly useful for creating questions in a quiz that spans
several slides.

e In addition to inserting interactive content from within PowerPoint, you can download apps
from the Office Store website at https://store.office.com/appshome.aspx and insert them
into your mix. However, Office Mix collects data only for those apps that you insert from the
Lab Appsfor Office box that appears when you click Video Quizzes Apps on the Mix tab.

Export options

There are several ways to export a mix, depending on how you want to use it and who you want to
make it available to. You access each export option on the Mixtab:

Pt AR o
-ruj LT "_-!._.'l Ej; T\-} bW
Preview Upload My Export Exportto Publish to

to Mix  Mixes | to Video SCORM 0365 Video
Mliz Yideo

Mix options
Preview

rnj Though not technically an export option, Preview lets you view your mix without first

L) publishing it or saving a potentially big file to your hard drive or other storage device.It's
similar to the Slide Show command in PowerPoint in that it runs your mix full-screen so
you get an idea of how your viewer will experience it. This command is only availablefrom
inside PowerPoint when you have Office Mixinstalled.

Preview

Upload to Mix


https://mix.office.com/MyMixes/Uploaded
https://store.office.com/appshome.aspx

ey Upload to Mix publishes your mix securely to your My Mixes page in the cloud onthe
Office Mix website. It converts your PowerPoint presentation (PPTX) file into arich,

Upload interactive video with a unique URL.
to Mix

You share your mix simply by sharing the URL, which plays the mix over the Internet in theviewer's
default web browser on any device. There's no need to save, keep track of, or send your mix files.
Each published mix appears on your My Mixes page and its URL never changes, even when you
updateand republish your mix. You can also use the URL to link or embed your mix on other
websites.

This is the recommended export option because it gives you control over who can view your mix,
and it also gives you data about how your mix was viewed and by whom. If you require this data or
the mix itself to be present on your own servers, use one of the video export optionsbelow.

My Mixes
22 Though not technically an export option either, My Mixes opens the My Mixes page onthe
s Office Mix website in your default web browser. It provides an easy way for you to seeyour
MMY list of published mixes, play them, and view the data collected for each one. It's also useful
IXes

if you want to give the mix you're working on a name similar to (or different from) mixes
you already published but you don't remember theirnames.

Video export options
Export to video

E’j Export to Video lets you convert your mix to a video that viewers can watch offline. This
= option saves the video to the location you specify; it is not stored on your My Mixes page
Export on the Office Mix website.
to Video
One clear benefit of saving your mix as a video is that you can distribute however you choose,
upload it to a learning management system (LMS), upload it to YouTube or other sites, etc. But
because it'sa video and not a mix, the interactive elements will appear in the video but they will
not beinteractive. Specifically, viewers will not be able to click or otherwise interact with:

e Hyperlinks
e Quizzes
e Polls

e Simulations
e Other interactive content inserted from Quizzes Videos Apps

In addition, Office Mix will not collect data about videos. Analytics data is available only for mixes
(not videos) on your My Mixes page on the Office Mix website.

Export to SCORM
e Export to SCORM converts your mix to a SCORM package that you can upload to yourLMS.

== SCORM packages appear as courses in your LMS and are generally stored on the same
Eg"g;::ﬂ” server as your LMS. If you included high-fidelity audio-video elements in your course,

viewers will most likely need a high bandwidth connection to view it properly.


http://mix.office.com/

Note that this export option has the same limitations as Export to Video: interactive elements that
you inserted in your mix will no longer be interactive after you export your mix to this format; and
analytics will not be collected or made available by Office Mix.

Office Mix best practices

Congratulations! You decided to use Office Mix for your recorded lessons rather than investing in
traditional video-making equipment includes screencasting software, pen annotation, interactive
whiteboards, high-end  microphones, video cameras, recording software, and
compositing/editing software.

But that's just the start. Below are seven steps for creating video-based lessons that will help you create
mixes that engage your students' minds and attention:

1. Keep it short (6 minutes orless).
Shorter videos are much more engaging to students who are growing up in the YouTube generation
than videos the length of a TV program or more. Studies show that engagement drops sharply after
just six minutes. If you plan your lessons so that one video equals one topic, you're more likely
students to keep your students' attention with many short videos (e.g., five six-minute videos) than
with one long video (e.g., one 30-minute video).

2. Don’t feel compelled to usevideo.
Video slides take longer to record, and more iterations to get right. A common practice is to usea
full screen video for the introduction and then switch to audio and inking. This makes it much
faster to create your mix. However, videos that show you talking directly to your students are
more engaging. Think about when and where students will benefit most from seeing you speaking
to them, either in a thumbnail video in one corner of the mix, or in a full-size video that takes up
the entire area of the mix.

3. Amateur, authentic videos beat high-end, rehearsed recordings.
Videos with an "indie" feel, meaning they can be rough-around-the-edges but communicate your
message clearly, are often more engaging than high-fidelity studio recordings that feels as if they've
been rehearsed over and over. To give your videos more of an authentic look and feel, recordthem

in an informal and familiar setting, like the office where you hold office hours for students. You'll
save money by not renting a sleek and polished space, and you'll create the one-to-one atmosphere
that will put your students at ease.

4. Draw on your slides just like you'd draw in your classroom.
Tutorials in which instructors draw on tablets, like the ones produced by Khan Academy, are easier
to follow than PowerPoint slide shows or screencasts that run from start to finish without the
instructor calling the students' attention to specific information. Introduce motion, animation, and
inking into your lessons, along with audio or video or yourself speaking, so that students can follow
along with your thought process.

5. Plan your lessons with MOOC in mind.
High-quality, pre-recorded classroom lectures are not particularly engaging, even when they'recut



into shorter segments for a MOOC (Massive Open Online Course). If you must record a classroom
lecture, keep the MOOC format in mind and partner with instructional designers who understand
the best way to deliver online training or education.

6. Be energetic, enthusiastic, and when appropriate, funny.
Have you ever watched a video in which an instructor drones on? Delivering the same material with
energy and enthusiasm can makes a huge difference, especially if you inject your own brand of
humor into it, the same way you would in a classroom. If you think you need to speak slowly so that
students can follow along, remember that they control the playback: they can pause and rewind the
video, and watch it as many times as they need to.

7. Focus on sequential viewing for lectures, non-sequential viewing for tutorials.
Students engage differently with recordings of lectures and tutorials. They're likely to watch a
lecture from start to finish, whereas they're more likely to jump in and out of different parts ofa
tutorial. So add support for the non-sequential viewing experience of your tutorials, such asthe
ability to: skim a section (by adding callouts that summarize slide content); jump around (by
inserting hyperlinks to other slides and slide sections); and enter the tutorial at any slide.

Slide Recording: tips & tricks

Slide recordings are a powerful way to add audio, video, and inking to a presentation. But what happens
when you create a slide recording of a slide that contains many effects, like animations, transitions,
sound effects, etc.? To make sure your slide recording always plays the way you want, Office Mix will
not record the following slide elements:

e Triggered animations (that you add by clicking Trigger on the Animations tab)
e Sound effects (that were not recorded in Office Mix but were instead added to a motion
path animation on the Animations tab)
o Hyperlinks that are inside a table or that open a custom slide showCheck out the tips and tricks
below to make sure your slide recording plays back the way you expect.

Audio tips & tricks

If you haven't already read Getting Started: tips & tricks, be sure to read tip #4: Test your audio level
before you start recording.

1. Invest in a better mic than what's built into your tablet or laptop.
Office Mix does not recommend a particular make or model of microphone, but it's easy to find
good alternatives to what's built into your computer by searching for "high quality podcast
microphone" on your favorite electronics shopping sites. See search results by Bing.

2. Choose the right Audio and Video setting for what you plan to record.
By default, Office Mix is set to record audio at a low bit rate, which is suitable for voice recordings,
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and keeps your mix file smaller. But if you plan to record music, for example, and you wantto
capture the full range of that music at high fidelity, then you should change the default setting. To
do this:

o Inthe Audio and Video pane, click the Settings button that looks like a gear:

Audicand Video & &

o Inthe dialog box, clear the Audio for voice (noise reduction and auto-adjust volume)
checkbox.
o Click OK.

For more information about the different audio settings and how to set up your mic correctly, watch
Mix Audio.

Video tips & tricks

Because Office Mix keeps track of timings for your audio, video, and inking, adding other elementsthat
have timings (animations, transitions, etc.) to a slide could produce unpredictable results. For that
reason, follow these video tips to make sure that your screen recording always plays the way you
expect.

1.

Do not insert more than one video on a slide.
If a slide contains two videos, Office Mix won't know which one to play first. However, there isa
workaround if you want to insert two videos on aslide:

o Create two identical-looking slides.

o On the first slide, insert video 1 and an image of video 2.

o Onthe second slide, insert video 2 and an image of video 1.
When your mix plays, video 1 will play on the first slide and video 2 will play on the second slide.
But to the user, it will look as if video 1 will play and then video 2 will play on the sameslide.

Do not insert an animation on a slide that contains a video.
The same challenge applies to this situation as to the situation above. The good news is thatyou
can use the same workaround:

o Create two identical-looking slides.

o Decide whether you want the animation or the video to play first.

o On the first slide, insert the element you want to play first, and also insert an image ofthe
element that will play second. For instance, if you want a video to "float in" to yourslide,
add that animation effect to an image of your video.

o Onthe second slide, insert the element you want to play second and an image of the
element that played on the slide 1.

You cannot ink on a video or interactive content (the one you insert by clicking Quizzes Videos
Apps).

You can change the size of your video after you create your slide recording.

Before you create a slide recording, you need to select either Thumbnail or Full Screen below the
video preview. After you finish recording and close the Slide Recording window, the video will
appear on your slide. At that time, you can dynamically resize it the same way you would resize
any other shape on your slide.

Choose the right Audio and Video setting for what you plan to record.
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By default, Office Mix is set to record video at a low resolution, which is suitable for most videos,
and keeps your mix file smaller. But if you want to record in high definition (HD) for a mix thatyou
plan to save as a video and not upload to the Office Mix website, then you need to changethe
default setting. To do this:

o Inthe Audio and Video pane, click the Settings button that looks like a gear:
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o Inthe dialog box, select the Record HD Video (not for web) checkbox.
o Click OK.

Inking tips & tricks

If you haven't already read Office Mix best practices, be sure to read tip #4: Draw on your slides just like
you'd draw in your classroom.

1. For best-quality ink strokes, use a digitizing tablet instead of a mouse.
A pen or stylus will give you more control over what you draw than a mouse (or a keyboard, for
that matter).

2. Focus viewers on the inking and not on video of your drawing.
Unless you're an art teacher and you want your students to see you in the act of creatingink
strokes, don't include video of yourself inking because it will divide their attention. But do include
audio of yourself talking while you're inking so students know why you're drawing their attention
to something on your slide.

3. Move your microphone far away from your input device.
When possible, ink as far away from your mic as possible to avoid the clicking sound that pens,
styluses, and mice make when you draw on aslide.






